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% Né6i dung chinh - IS

= M6t sO rng dung tich hop trong Windows

= M6t sO ing dung quan ly, thao tac trén tap tin
= ng dung doc van ban Acrobat Reader

= B6 rng dung van phong Microsoft Office

= M6t s6 ng dung trén Internet

Mét s6 churong trinh tng dung 4
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% Néi dung chinh e

= M6t sO ing dung tich hop trong Windows
> ng dung tinh toan: Calculator
> Ung dung soan thao van ban: Notepad
> Ung dung dd hoa: Paint
> Ung dung xem phim: Windows Media Player

Mét sé chuong trinh (g dung 5
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% Mét so6 trng dung trong Windows  jF—ss====

= ’ng dung may tinh (Calculator)
Start > All Programs > Accessories > Calculator
> May tinh chuan

Mac dinh hoac chon View > Standard

F Calculator |:||:E|
Edit Wiew Help

phuc vu tinh toan
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% Mét so6 trng dung trong Windows  jF—ss====

= ’ng dung may tinh (Calculator)

Chon View > Scientific

Hé thong nut
chon lwa hé co sb

F Calculator

4 ) —
H é théng Edit  Wiew Help :
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% Mét so6 trng dung trong Windows  jF—ss====

-

= ’ng dung soan thao van ban don gian (Notepad)

Start > All Programs > Accessories > Notepad

B Untitled - Notepad |._||E|rg|

Menu

hé théng Notepad overview N

Motepad is a basic text editor that wyou can use to create simple documents.
The most common use Tor Wotepad is to wiew or edit text [.‘cn-ctg| files,
but many users find Wotepad a simple toaol for creating web pages.
Because Notepad supports only very basic formatting,
you cannot accidentally save special formatting in documents
that need to remain pure text.
This s especially useful when creating HTML documents
for a weh page because special characters
or other formatting may not appear in your published web page
Or may even Cause arrors.
¥ou can save your Notepad files as Unicode,
ANSI, UTF-8, or big—endian Unicode.

Thanh These formats provide you greater flexibility when
working with documents that use different character sets.

cuon
ngang
Mét sé churong trinh (ing dung 8
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% Mét sé trng dung trong Windows /===

= ng dung d6 hoa don gian (Paint)

Start > All Programs > Accessories > Paint

;i_-:' THCS - el <
.......................... Vung

SATT “;E% vé

Ten tiac ca s

Thanh

< ’

g ENTEENNENTEENR
R RN Cme

IF:::r Help, click Help Topics on the Help Menu. 456,145 203x51

Mét s6 churong trinh tng dun
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% Mét sé trng dung trong Windows g —

= ng dung xem phim (Windows Media Player)

Start > All Programs > Windows Media Player

G Windows Media Player

File  Wiew

Play Tools Help

or i

ervices

Thanh
diéu khién

Mét sé chuong trinh (g dung 10
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g Néi dung chinh | —

>

= M6t s (’ng dung quan ly, thao tac trén tap tin
» ng dung quan ly tap tin Total Commander
> U'ng dung nén tap tin WinZip

Mét sé chuong trinh (g dung 11
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% Mét sé rng dung g —

= Windows Commander: U'ng dung quan ly tap tin
giong nhw Windows Explorer.
Start > All Programs > Total Commander
= M6t sO chirc ndng co ban
» Tao thw muc: F7
» Tao tap tin: Shift + F4
» Xem ndi dung tap tin van ban (.txt): F3
» Sao chép tap tin/thw muc: F5
> Di chuyén tap tin/thw muc: F6
» Xoa tap tin/thw muc: F8

Mét sé chuong trinh (g dung 12
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¥ Mét sé rng dung

= Total Commander 7.01 - University of Amsterdam Z E|fg|

Files Mark Commands Met Show  Configuration  Skark : Help

2 OMIBYW( A e OO EL AN S B

Lnone_] 5.763.136 k of 8.377.864 k free (. Lnone_] 5.763.136 k of 8,377.864 k free (.

c:ASVAR® * v * v

THame Ext Size Date Abtr THame Ext  Size Date Attr

| <DIR> 10/03/2008 15:59--- ﬁl [..] <DIR> 10/02/2008 23:35--- i~
[ J[addins] <DIR> 10/03/2008 04:20—
[JAppPatch] <DIR> 10/03/2008 04:22--
[JIConfig] <DIR> 10/03/2008 04:20----
[J[Connection Wizard] <DIR> 10/03/2008 04:20----
[J[Cursors] <DIR> 10/02/2008 21:27-- —
[J[Debug] <DIR> 10/03/2008 04:22--
(& [Downloaded Program Files] <DIR>  10/02/2008 21:29-s
[J[Driver Cache] <DIR> 10/03/2008 04:20----
[J[ehome] <DIR> 10/03/2008 04:21--
[ [Fonts] <DIR>  10/02/2008 23:18-F
[J[Help] <DIR> 10/02/2008 21:28---
[Jlime] <DIR> 10/02/2008 21:31-—
[T [inf] <DIR> 10/02/2008 23:24--h-
[T [Installer] <DIR> 10/03/2008 15:33-hs
[TJliaval <DIR> 10/03/2008 04:20----
[JMedia] <DIR> 10/03/2008 04:21--
[J[msagent] <DIR> 10/03/2008 04:21--
[JImsapps] <DIR> 10/03/2008 04:20----
[ [mui] <DIR> 10/03/2008 04:21--
[Offline Web Pages] <DIR> 10/02/2008 21:2%--
[JIpchealth] <DIR> 10/02/2008 23:16—-
[JIPeeMet] <DIR> 10/03/2008 04:21--
[J[Prefetch] <DIR> 10/03/2008 15:48- -

Ok /0kin0 /0O files 0k /6,191 kin 0/ 82 files, 0 / 38 dirs)

cAWINDOWS> v
F3 Yiew F4 Edit F5 Copy F6 Move F7 MewFolder F& Delete Alt+F4 Exit
M6t s6 chwong trinh teng dung 13
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g Mét sé trng dung S —

7
~

= WinZip: Ung dung nén va giai nén tap tin/thw muc

Start > All Programs > WinZip > WinZip

&) WinZip Pro

i File Actions Wiew Jobs Options Help :
-g Bl = |_[____5_. b ~ a2 B BE
CIpen Fawvarites Add Exckrack Encrypk Wig Zheckouk Wizard Wigm Shyle
Marne Type Maodified Size  Ratio Packed Path
Choose "Mew" ko create or "Open” ko open an archive 00
Mét sé chuong trinh (g dung 14
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V 4

w MOt so wrng dung

= | ocal Disk (C:)
File Edit Wiew Faworiies Tools  Help

'\_) Back -J

i_ﬁ pSearch H:" Folders v

Address |<ee C|

1. Chubt phai
vao tap tin/thw
muc can nén

File and Folder Tasks

ﬂ Rename this Folder
(3 Move this folder
Copy this Folder
&8 Publish this Fiyees

2. Chon

&4 Share this F
(5] E-mail this f
¢ Delete this Folmer

Other Places

3 My Computer
B My Docurnents

[5) Shared Documents
‘ﬂ My Mebwork Places

Documents and Settings

WINDOWS I Images

L —
” I~ ? Sy
Open

Explore
Search...

3. Chon

sharing and Security, .,

3 130 Add to Zip file.
Serd T , Li Add to Sof
Ena 1o 3l Add to recently used Zip file »
Cut 3 Zip and E-Mail Software. zip
Capy 3 Zip and E-Mail Plus. ..
Configure
Create Shorbcut 2 7
Delete
Rename
Propetties

Mét sé chuong trinh (g dung
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V 4

w MOt so wrng dung

= Thwc hién giai nén

= | ocal Disk (C:)

O Back

File Edit Wiew Faworiies Tools  Help

@ - l_ﬁ pSearch H:" Folders v

Address |<ee C|

System Tasks

tap tin/thw muc
can giai nén

File and Folder Tasks

ﬂ Rename this File
[ Move this file
Copy this File

&N Publish this file to the
'eb

Other Places

Q My Computer
[Ej My Docurnents

[5) Shared Documents
‘d My Mebwork Places

Documents and Settings

WINDOWS

Software

Print
Explore

Open With

Open with WinZip

»
4

'
Il:_) Program Files

Irnages

o

Send To

Cut
Copy

Create Shorbcut
Delete
Rename

& Extract ta...
3 Extract to here
LI Extract to Folder C:\Software
CHIE-Mail Software, zip

CH Encrypt

dl Create Self-Extractor (Exe)
3 Configure

Propetties

Mét sé churong trinh tmg dung
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% Néi dung chinh -

= ng dung doc van ban Acrobat Reader

Mét sé churong trinh tmg dung 17
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% Ung dung Acrobat Reader T T —

—

= Adobe Reader |a mdt san pham ciia hang Adobe

System, cho phép xem cac tai lieu PDF (Portable

Document Format).

> PDF la mét dinh dang tap tin van ban kha phd bién cua
hang Adobe Systems.

> Viéc hién thi van ban PDF khéng phu thuéc vao méi
trwdng lam viéc clia ngudi st dung (cau hinh may,
phan mém va hé diéu hanh) nén thuan tién cho phat
hanh sach, bao hay cac tai lieu khac qua mang Internet.
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% Ung dung Acrobat Reader S —

—

= Acrobat Reader dwoc cung cap mién phi
= Cai dat:
1. Tai tap tin cai dat Acrobat Reader trén trang web
www.adobe.com

2. Kich hoat tap tin cai dat
3. Thuwc hién cac bwoc theo hwdng dan trén man hinh

cai dat.

Mét sé chuong trinh (g dung 19
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% Néi dung chinh o

= B6 rng dung van phong Microsoft Office

Mét sé churong trinh tmg dung 20
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% Bo6 trng dung Microsoft Office QT —

= Microsoft Office |a bé &rng dung van phong cua
hang Microsoft.
= Cac phién ban:
» Microsoft Office 3.0, 4.0, 4.3
» Microsoft Office 95, 97
» Microsoft Office 2000, XP
» Microsoft Office 2003 (dwoc st dung trong thwc hanh)
» Microsoft Office 2007
» Microsoft Office 2010

Mét sé chuong trinh (g dung 21
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% Bé wrng dung Microsoft Office g —

= Microsoft Office 2003 gom cac trng dung:
> Microsoft Word: soan thao van ban.
» Microsoft Excel: théng ké, tinh toan, phan tich.
» Microsoft Outlook: quan ly thw dién tc.
> Microsoft Powerpoint: trinh chiéu.
» Microsoft Access: quan ly co s& di liéu.
> Microsoft Visio: vé biéu do.
> Microsoft Frontpage: thiét ké trang web.
» Microsoft Project, OneNote, Publisher, InfoPath,...

Mét sé chuong trinh (g dung 22
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% Néi dung chinh e

= M6t s (’ng dung trén Internet
> Ung dung duyét web Internet Explorer
> ng dung thw dién t& Yahoo! Mail
> ng dung tan gau Yahoo! Messenger
> Ung dung tim kiém théng tin Google Search

Mét sé chuong trinh (g dung 23
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% Mot so rng dung trén Internet G —

L ~

Internet Explorer: U'ng dung truy cap vao cac
trang web trén mang Internet.

Start > All Programs > Internet Explorer

A Trudng Dai Hoc Khoa Hoc Td Nhign TP HE Chi Minh - Trang Chi - Microsoft I..[2 |[B][X]
File Edt \Miew Favorites Tools Help o '.,'

____________________________ ]
\H) \‘_/l @ @ \-_;j ,‘:j Search {E’ Favorites e Media @ [‘/:{ - > Than h
Adgress ‘@ bk f feas hermons , edu,wvnf b ‘ Go Links ** - &Snaglt . |-j" Cuén

R @!ﬂ‘ o

5, IS (GEMT+7) % TuyEn sinh Cao dang Quic tE (ITEC)

Chao mirng cac ban dén v&i website Vung
Trucgng PH Khoa hoc Tu Nhiéen hién thi
< .
Gidi thigu ——_trang web
- ° | Ewrgic thanh 18p theo guywét dinb 1236/G0DET cha bd
| 30431996 trén co s kach ra b Trudng BH Tang ha
gia wao BH Quic gia TPHCM, Trudng higén cd & khoa:
Cdng nghé thdng tin, Yat Ly, Haa hoc, Sinh boc, Bia
| Dign b - wign thdng v 4 BS mdn truc thude; 7 phan
P | nang; 11 Phong khi nghigm & 15 krung t&m nghign o
=an xudk dich vu....
i—hi FiEF

Thanh
dia chi

1 chanh

b
< | >

@ Dane ) Internet
Mét sé chuong trinh (g dung 24
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V 4

w MOt sO trng dung trén Internet

= Yahoo! Mail: Dich vu g¥i nhan thuw dién tu.

Dia chi: http://mail.yahoo.com

23 Yahoo! Mail: The best web-based emaill - Microsoft Internet Explorer

File Edit Wiew Favorites Tools  Help

@Back = e @ @ @ ;h pSearch {?Favurites @Media @ Di::(:' :‘\F _J ﬂ

Address |@ hitps: fflogin, yahoo, comjfconfigflogin_verify2?e. sro=ym V| Go | Lnks ¥ § Gsnaa: B B

YAHOO! MAIL ahont - ralp

P

Bang ky

Chat right from Don'thave a . Lo

your Inbox el mail moi
BN

Sign up for Yah

Already have a Yahoo! ID?

Sign in.
Now you have a whole new way to connect ; .
with friends in the New Yahoo! Mail. @ Are you protected?
4 Create your sign-in seal.
OMhry?)
E,ZB See which of your Mail contacts are online at a glance.
“ahoal 1D

bang nhap
vao malil
da co

@ Chat right now — no download ar setup required |
(e.g. free2rhymei@yahoo.com)

Instantly go from email to chat and back again. Fassword:

[ Keep me signed in

for 2 weeks unless | sign out
[Unicheck if on & shared computer]

s Find out how to chat with friends from your Inbo:x today. Info

Faorget your ID or password? | Help

@ é ' Inkernet

<

Mét sé chuong trinh (g dung 25
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% Mét sé trng dung trén Internet gy —

/

= Pang ky tai khoan Email mai:

) Yahoo! Registration - Microsoft Internet Explorer

File Edit  Wiew Fawarites Tools  Help 'a.
eBack - @ - @ @ \::j pSearch ‘E’n'\'g-‘Favorites *Media @ Efrgv ; E \_J ﬂ
Address |@ https: ffedit.yahoo, comregistr ation? . intl=us&new=18. done=http% 34/ mail yvah V| Go | links 7 @ - @cnaglt B
~
HOO' rahoo! - Help 1
YA L
K . Already have an ID or Mail address?
Hi there!
& |
We'll get you set up on Yahoo! in three easy steps! Just
'l;_;_:.lr answer a few simple questions, select an ID and password, Forget your passward or Yaheo! ID7
! and you'll be all set.
VIV (I N Lprefer contert from, |_‘r‘ah0u:u! L5, in English A
]
- Tén Vé HO Jell us a!)out yourself... i
ST ! Wy Mame |Tin Hoc Co So Bo Man 1 W
- Gigi tinh [ty ame I | ;
- Ngay sinh - :
e ! Birthday |January V||1 ||1982 | I
- 1
Noi o R i -
~ AL >
Tén tai khoan
2. Select an 1D and password 2 e a oa
Yahoo! ID and Ernail hmthes2008@yahoo.com  Change
~ N 2 F d Strength
Nhap mat khau Password sasess e
" " Capitalization matters. Use & to 32
characters, no spaces, and don't use wour
name or Yahaoo! 1, n . n R
<! Nhap lai mat khau
Re-type Password |essses | .
I@ é 0 Inkernet
Mét sé chuong trinh (g dung 26
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w MOt s

= Pang ky tai khoan Email méi (tiép):

M Yahoo! Registration - Microsoft Internet Explorer.

File  Edit  ‘“iew Favarites  Tools  Help a'

@Back - @ - @ @ \/_;j pSEarch ‘*-Ei‘g‘Favorites eMedia @ [}—21 "*_\ﬁ \_J ﬁ

Address |@ https: fiedit. vahao. camfregistration? intl=usénew=18. done=http %54/ fmail. yvah V| Go Links > @ < & Snaglt @ IETl

53

3. In case you forget your ID or password...

Altarnate Email | |

securty Question |What is the name of your favarite book? V|

Your Answer |Harr3t Fotter |

Uze 4 characters or more — not zase sensitive.

Cau hdi va cau
Just a couple more details...

Type the code shown tra Io”\l bl mat lfhl
guén dia chi

Nhap ma FTHBL hodc mat khau

xac nhan

[B]x] yau agree? I have read and agree to the Yahoo! Terms of Service and Yahoo! Privacy Policy, and to receive
important communications from YYahoo! electronically.

R \7 | harve alzo read and agree to the Mail Terms of Service,
C h On de For your convenience, these documentz will be emailed to your Yahoo! Mail account.
2
dong y

Create My Account Cancel

Tao tai khoan

| £

@ N\ Z é 0 Inkernet

Mét sé chuong trinh (g dung
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Y 4

0 trng

w MOt s dung trén Internet

= Pang ky tai khoan Email méi (tiép):

<M Yahoo! Registration Confirmation - Microsoft Internet Explorer,

File Edit View Favorites Tools  Help al

@Back < \_) @ @ \_h pSEarch {?Favorites eMedla -‘-5 ,r_{ ?,, J ﬁ

* h &Snaglt @ [51"
Thong bao =
YaHOO! _~ thanh cong J

Congratulations, Tin Hoc Co So!

A confirmation message was sent to you via emall.

Address |@ https: [ fedit. vaboo, comregistration; _ylk=AowHZASWRSDEDY 1 D64 (

Below are your account details = Print Accourt Details VéO hép thU’
You will need this information to sign in to Yahoo! and to reset )
your password in case you forget it. Please print and keep this Ready to experience
information in a safe place for future reference. Yahoo! Mail?
Yahoo! ID & Email bmthes2008@yahoo.com
. Continue )
~ - e
Thoéng tin Birthday January 1, 1982
té| khoén Security Question YWhat is the name of your favorite
boaok? [ Install the new yahoo!
Toolbar and make Yahoo!
Iy Answer Harry Potter Mail faster
(please follow the next few steps
to get your new toalbar)

Marketing Preferences

Your Marketing Preferences: Select and customize the categories of communications you receive about v
£ | &
I@ Done é 0 Inkernet
Mét sé chuong trinh (g dung 28
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N

Y 4

Mot so wrng

=

= Hop thw dién

File  Edit  WYiew

A Yahoo! Mail (bmthcs2008) - Microsoft Intern

Favorikes  Tools  Help

@Back < \_;J @ @ :;j pSEarch

dung trén Internet

twr

Tén tai khoan

ites *Media @ [}—gv ‘“:_\ﬁ \_J ﬁ

Address |@ hktpe s maz. mail vaboo, comfdeflaunch

v|Go Links * & Soraat B OEf

bmthcs2008
-YAHOO"'@)MAIL Sign Qut, My Account,ﬁa‘]ngalsmz Falnme

¥r | Search the ek, |

&J Check Mail @ Mew +

| [ {.'—\r Home || Inbox 1 message x |

WEB SEARCH

Mohile | Options ™ | Help =™

Good Morning, Tin!

|Q' search Mail, .

@; Cabo San Lucas
& Find deals naow!

E* You have one unread message in your Inbox

[_Yinbox [§Y

Vate far Your
Top Actress

E Used Car Prices
Local Listings

- Top Stories [ word Entertainment Sporks | Local
%] Drafts 2
= ¥ Sent Histaric bailout bill passes Congress; Bush signs (AF)
dé ™ Spam Emphy &P - With the economy on the brink of meltdown and
_ b Ermpt elections looming, a reluctant Congress abhruptly
> = I Tras MpLy reversed course and approved a historic $700 billion
gLPl T2 Contacts Add governrment bailout of the battered financial industry.,..
2 Calendar =Wells Fargo agrees to buy Wachovia; Citi objects (AF)
i) Motepad [|| =Mewspapers get complaints for O%D ad on Muslims (AF)
| . . . . e
> & AllFeeds & ||| = Palin questions McCain's concession of Michigan (AF)
b= My Folders

P-il = Analysis: Stable Irag could influence Mideast (AF)

r HOT DEALS on
‘l_ “ahoo! Shopping
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